
Cookbook - Chem_DX120 manual
1

Chemistry Lab Cookbook
Dionex DX-120 Manual, v210.0

Instrument:
Dionex DX-120

ODP    #:  04995
Model #: DX-120

Website:
http://www.dionex.com

Software:
Peaknet, v3.9

Documentation Available:

Document Name/Title/Number Source Version Associated
Instrument(s)

Associated
Measurement(s)

Dionex DX-120 Ion Chromatograph Operator's
Manual

Dionex Document
No.
031183,
Revision
02; March
1997

DX-120 Ion
Chromatograph

Sulfate, chloride,
calcium, sodium,
potassium, and
magnesium.

Dionex DXP Pump Operator's Manual Dionex Document
No.
034437,
Release 01;
May 1991

DX-120 Ion
Chromatograph

n/a

Dionex Misc. Binder Dionex/In-
house

n/a DX-120 Ion
Chromatograph

n/a

Dionex PeakNet Sofdtware Media Binder Dionex 8-Aug-97 DX-120 Ion
Chromatograph

n/a

Dionex PeakNet Software User's Guide Dionex Document
No. 03914,

DX-120 Ion
Chromatograph

n/a

DX Columns and SRS Dionex/In-
house

n/a DX-120 Ion
Chromatograph

n/a

DX-120 Setup & Example Runs Binder In-house n/a DX-120 Ion
Chromatograph

n/a

SpectraSystem AS3500 Autosampler Field
Repair Manual

Thermo
Seperation
Products

Dec-93 DX-120 Ion
Chromatograph,
AS3500
Autosampler

n/a

SpectraSystem AS3500 Autosampler
Reference Manual

Thermo
Seperation
Products

Mar-92 DX-120 Ion
Chromatograph,
AS3500
Autosampler

n/a



Cookbook - Chem_DX120 manual
2

I.  PRINCIPLE OF METHOD

The Dionex DX 120 Ion Chromatograph performs isometric ion analysis applications using conductivity
detection.

A. Definitions

Ion Chromatography is a liquid chromatography technique using ion exchange mechanisms and
suppressed conductivity detection for the separation and determination of anions and cations.

Ion Exchange is a process by which certain undesired ions of a given charge are absorbed from a
solution, within an ion-permeable absorbent, and are replaced in the solution by desirable ions of similar
charge from the absorbent. Basically, it is a separation technique which uses two phases in contact with
each other: a stationary phase (solid) and a mobile phase (liquid). Upon introduction into the system, the
sample is carried by a mobile phase (eluent) which enters the separator column where ion exchange
occurs.  Separation of the ions on the column results from the fact that different ions react differently to
the liquid (eluent) and the solid stationary phase (column). The ions are moved by the eluent at varying
(but reproducible) speeds along the column. When the eluent containing the separated sample ions exits
the column, it enters the suppressor.

Since the detector used in ion chromatography is a conductivity detector and the eluents used are acids or
bases with high inherent conductivities, a system is needed to remove the background conductivity due to
the eluent. This is the job of the suppressor.

After the suppressor, the solution enters the conductivity cell that records the conductivity of the cell.
Conductivity detection is based upon the electrical conductivity of an ionic solution when placed
between two oppositely charged electrodes. The presence of ions in the solution allows electrical current
to flow between the electrodes, completing the circuit. At low concentrations, conductivity is directly
proportional to the concentrations of the conductive species in the solution. The total ionic concentration
of the solution in the cell and the temperature of the solution affect the linearity of this relationship.
Conductivity units are Siemens (S/cm).

B. Components of Dionex DX 120

The DX 120 is an integrated system which includes a pump, injection valve, chromatography components
(columns and suppressors) and a detector. The DX 120 can be controlled locally, using the front panel
keypad and display, or remotely, from a PeakNet workstation. The PeakNet workstation consists of a
computer with a Dionex DX LAN interface card and PeakNet software.

The DX 120 can be configured as a single-column system or a dual-column system. The dual column
system allows switching between two sets of columns (column select mode) or between two eluents
(eluent select mode). With the eluent select mode, the DX 120 can perform step gradients.

The DX 120 system on board the Joides Resolution is set up to run in the Column Select Mode.

The Column Select Mode allows switching of flow from one column set (A) to the other (B). This mode
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requires using two additional valves over the single column system: an eluent switching valve which
selects the eluent reservoir to be used and a column switching valve which directs flow to the selected
column set.

1. Eluent Source

In the dual-column system, eluent sources consist of two-liter pressurized reservoirs located on top of  the
DX 120 unit. There are two reservoir bottles: one for Elu A (column set A) and one for Elu B (column set
B). Helium pressurizes the bottles via pink tubing. The eluent will flow from the bottles to the pump via
clear plastic tubing.

The Eluent Switching Valve is used to select the eluent reservoirs to be used during column switching
sequence. Refer to section I.B.4. of this manual.

2. Pump

The pump is located on the right side of the main compartment (see Figure 1) (P2-4 DX120 Operator.
Manual). It is a single piston pump that can deliver a flow rate from 0.5 to 4.5 ml/mn. The eluent flows
from the pressurized containers through the pump from the bottom to the top of the pump. The eluent then
goes to the bleeding valve,  pulse damper (that gives the pump the necessary back pressure), and injection
valve of the DX 120 (or rheodyne valve of the AS3500 autosampler).

The DXP Pump Operator Manual (document # 034437) provides information on the following
procedures:
- liquid line connections (section 1.4);
- priming of the pump (section 2.1);
- routine maintenance (section 3.1);
- troubleshooting (section 3.2).

Note:  If the DX 120 is idle for 90 mn, the pump flow automatically decreases to 1/20th of its current
flow rates and SRS cycles on and off.

The flow paths are constructed of PEEK (polyetheretherketone) compatible with all acids, bases, and
common phase eluents used in ion chromatography. From the pump to the pulse damper, one should use
PEEK of 0.02 in diameter (20000 PEEK). From the pulse damper to the injection rheodyne valve, one
should use PEEK of 0.005 in diameter (5000 PEEK). From the rheodyne valve to the injection valve, one
should use 20000 PEEK (also used for the waste lines). A 0.01 in diameter PEEK (10000 PEEK) will be
used  for the flow paths from the injection valve till after the detector. This should limit the dead volume
in the tubing.

Information on the installation of the PEEK tubing and double cone ferrules is provided in the Installation
of Dionex Ferrule Fitting Manual.

3. Sample Injection Valve

The sample can be loaded manually or injected automatically using an AS3500 autosampler.
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3.1. Manual Injection

The sample can be loaded manually with a syringe inserted into the port of the front of the DX 120. The
sample is pushed into a sample loop that is connected to a rheodyne injection valve located on the inside
front door of the DX 120 (see Figure 2) (P2-12 DX120 Operator. Manual).

The rheodyne injection valve has two operating positions: Inject (ON) and Load (OFF). In the Load
position, sample is loaded into the sample loop, where it is held until injection. In the Inject position,
sample is swept to the column for analysis.

Eluent flow through one of two paths, depending on the valve position (see Figure 3 for flow schematics):
(P2-13 DX120 Operator. Manual)

- In the Load position, eluent flows from the pump, through the valve, and to the column, bypassing the
sample loop. Sample flow from the syringe through the valve, and into the sample loop; excess sample
flows out to waste;
- In the Inject position, eluent flows from the pump, through the sample loop, and on to the column,
carrying the contents of the sample with it.

On the front panel, the sample (Inject/Load) button will be used to inject the sample. Pressing the button
will switch the injection valve between the Load and Inject position and injects the sample into the
column system. Manual Injection can also be controlled using the PeakNet software. For details, refer to
the Operation Cookbook of this manual, section C. 3.1.

Note:  The DX 120 system is used with an AS3500 autosampler that automates the injection. If manual
injection is required, it is necessary to reconnect the injection valve by:
 disconnecting the red PEEK leading from the pulse damper to the autosampler rheodyne valve; and
reconnecting it to port 2 of  the DX 120 injection valve; and
- disconnecting the black PEEK leading from the autosampler rheodyne valve to port 2 of the DX 120
switching valve; and reconnecting port 3 of the injection valve to port 2 of the switching valve (see Figure
8). (P2-22 DX120 Operator. Manual)

3. 2. AS3500 Injection

Samples can also be injected automatically using an AS3500 autosampler. Samples are loaded onto the
column via a sample loop connected to the rheodyne injection valve of the autosampler. Similar to the DX
120 Injection valve, the AS3500 injection valve switches between an Inject (ON) and Load (OFF)
position as necessary to draw sample or solvent (in this case water) and to inject sample onto the column
(see Figure 4 for description of Autosampler's Major Components) (from Figure 3 from old dx100
manual).

Figure 5 (from figure 4 of old dx 100 manual) shows how the sample is introduced in the eluent stream:

- In the Load position: the sample is loaded into the sample loop, and the eluent goes in through port 6
and out to waste through port 5.
- In the inject position: the eluent goes in through port 6, picks up the sample from the sample loop, and
goes to the column system through port 5.

For a better understanding of the rheodyne valve and autosampler operation, refer to the "Theory of
Operation" section in the Autosampler Reference Manual (pp. 158-168).
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4. Column Switching Valve

The column switching valve is installed only in a dual-column system. The dual-column system, on board
the ship,  is set up to run in the Column Select Mode. In this mode, the switching valve is used to switch
applications, i.e. to switch column from column set A (used for anion separation) to column set B (used
for cation separation).

4. 1. Column Select Mode

Figure 6 illustrates the sequence of events when switching from column set A to column set B. (P2-18
DX120 Operator's. Manual).

In step 1, eluent A is flowing to column set A.
In step 2, the following occurs:
- a command is received to switch to column B;
- the eluent selection valve switches and eluent B begins flowing through the system;
- the injection valve switches to clear the previous eluent from the sample loop;
- a short delay occurs before the column switching valve switches to the new position. This allows eluent
A to continue through to column set A;

In step 3, when eluent A has been cleared from the lines, the column switching valve switches and flow
proceeds to the column set B. The injection valve returns to the Load position and the system is now
ready for use.

How to perform this sequence is explained in detail in the Operation Cookbook, section E.

4. 2. Switching Valve Description

The switching valve is the top valve located on the inside front door of the DX 120 above the injection
valve (see Figure 2). (P2-12 DX120 Operator. Manual). It is a ten port rheodyne valve which switches
between two positions: ON and OFF, as necessary, to control the appropriate eluent flow to the selected
column.

The switching valve is plumbed at the factory with the necessary tubing and fittings to connect the valve
to the columns, suppressors, injection valve, and cell. Figure 7 shows these connections. (PB-41 DX120
Operator. Manual)

Note:  When using the AS3500 autosampler, the autosampler rheodyne valve is connected directly to the
switching valve (port 2) and the pump pulse damper; the injection valve of the DX 120 is bypassed.

The valve ports are numbered counter clockwise from the bottom around the valve body. The  port are
connected as follows:
- in the ON position: 2 to 3, 5 to 4, 7 to 6, 9 to 8,  and 10 to 1 (port 10 plugged);
- in the OFF position: 2 to 1, 3 to 4, 5 to 6, 7 to 8, and 10 to 9 (port 10 plugged).

The  flow paths for Elu A and Elu B are as follows:
 Elu A path: 2, 3, 9, 8, 5, and 4.
 Elu B path: 2, 1, 7, 8, 5, and 6.
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Figure 8 summarizes the flow path through the Dx 120 system in the Column Select Mode (Manual
Injection): (P2-22 DX120 Operator. Manual).

•In the A position (ON): the eluent plus sample (or standard) goes in in port 2 of the switching valve,
out through port 3 to the AG4 guard column, to the AS4 column, to the anion suppressor. It then
reenters the valve in port 9, exits through port 8 to go to the conductivity cell. It exits the cell to go back
to the switching valve through port 5, out the valve through port 4, to renter the anion suppressor
(REGEN IN) and out to waste .

• In the B position (OFF): the eluent plus sample goes in in port 2 of the switching valve, out through
port 1 to the CG12 guard column, to the CS12 column, to the cation suppressor. It then reenters the
valve in port 7, exits trough port 8 to go to the conductivity cell.  It exits the cell to go back to the
switching valve through port 5, out the valve through port 6, to renter the cation suppressor (REGEN
IN) and out to waste.

5. Separators

A separator (column) is used to separate the various cations or anions contained in a sample.

5.1. Ion Pac CS 12 Cation Exchange Column (4 mm)

The Ion Pac CS 12- 4 mm column is designed specifically for the analysis of alkali metals (Li, K, Mg,
Ca), alkaline earth metals and ammonium. The CS 12 column stationary phase consists of a 8.0 µm poly
(ethylvinylbenzene/divinylbenzene) macroporous substrate resin that is functionalized with a relatively
weak carboxylic acid. It has both cation exchange and reverse phase properties. The CS 12 column also
has a carboxylate functionality, making it a relatively weak cation exchanger with a high selectivity for
hydronium ion. This makes it possible to use low ionic strength eluents to elute isocratically both
monovalent and divalent cations in a relatively short period of time.

Note:  The column can be used with 100% tetrahydrofuran or 100% aqueous without loss of
performance. DO NOT USE THE CS 12 COLUMN WITH ALCOHOLS, OR WITH BASIC ELUENTS.

The CS 12 column can be operated at flow rates up to 3 ml/mn. Optimally, the CS 12 should generate a
back pressure of approximately 800 psi when operated with eluent flow rate of 1 ml/mn.

An Ion Pac CG 12 guard column is normally used with the CS 12 column to prevent sample contaminants
from eluting onto the column. For maximum life of the column, the guard should be replaced as part of
the regular maintenance.

A troubleshooting guide is included in section 8 of "The Installation Manual of CS 12 Column and CS 12
Guard Column" (pp. 35 to 39). Section 9 of the manual covers column care (column start up, storage and
clean up--- pp. 39 to 40). Section 10 of the manual covers the installation instructions of the liquid line
fittings (PEEK and TEFZEL--- pp. 41 to 44).

5. 2. Ion Pac AS4 Anion Exchange Column (4 mm)

No documentation from Dionex relating to the  AS4 design and usage.
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6. Suppressors (SRS)

Suppressors are needed to remove (decrease) background conductivity due to the eluent. A suppressor
will increase analyte conductivity and eliminate sample counter ions.

The self-regenerating suppressor (SRS) consists of alternating layers of high capacity ion exchange
screens and ion exchange membranes separating the electrodes. The screens create a convoluted low
volume flow path for the eluent and provide an ion transport path for the ion exchange process (see
Figures 9 and 12) (see figures 2  in ASRS II and CSRS II manual). The SRS requires a constant water feed
through the regenerant chambers to achieve suppression.

Water will be delivered from the recycled eluent (in autosuppression recycle mode of operation). As the
eluent passes through the suppressor to the detector, it is neutralized to its weakly ionized form (see
Figures 10  and 13) (see figures 1 of ASRS II and CSRS II manual). After passing through the detector
flow cell, the eluent is redirected to the regenerant inlet of the SRS, thus supplying it with a source of
water (for electrolysis) containing minute amounts of diluted analyte. The amount of water flowing
through the regenerant chambers is therefore limited to the eluent flow rate. No need anymore for external
supply of water or regenerant!

Autosuppression with the SRS is achieved by utilizing electrolysis and electrodialysis with chemical
suppression (see Figures 11 and 14) ( see figures 3  in ASRS II and CSRS II manual). The water
regenerated within the SRS undergoes electrolysis to form hydronium ions (H3O+) in the anode chamber

and hydroxide ions (OH-) in the cathode chamber. The electrical potential applied to electrodes adjacent
to the ion exchange membranes facilitates the transport of ions through the membranes.

6.1. Autosuppression with the Anion Self-Regenerating Suppressor (ASRS II)

The chemistry of autosuppression with the ASRS II is described below and illustrated in Figures 9 and
11.

The ASRS II include two regenerant compartments and one eluent compartment separated by ion
exchange membranes. Defining a regenerant flow channel and an eluent flow channel on opposite sides of
the membrane, the eluent flow is in a direction that is countercurrent to the regenerant flow.

Electrodes are placed along the length of the regenerant channels. When an electrical potential is applied
across the electrodes, water from the regenerant channels is electrolytically hydrolyzed, supplying
regenerant hydronium ions (H3O+) for the neutralization reaction. The membrane passes these
hydronium ions into the eluent chamber resulting in the conversion of the electrolyte of the eluent to a
weakly ionized form. Eluent cations are simultaneously passed into the regenerant chamber to maintain
charge balance.

Figure 11 illustrates the autosuppression with the ASRS II. This example uses sodium hydroxide as the
eluent, but sodium carbonate/bicarbonate may also be used.The water regenerant undergoes hydrolysis to
form hydrogen gas and hydroxide ions in the cathode chamber while oxygen gas and hydronium ions are
formed in the anode chamber. Cation exchange membranes allow hydronium ions to move from the
anode into the eluent chamber to neutralize hydroxide. Sodium ions in the eluent, attracted by the
electrical potential applied to the cathode, move across the membrane into the cathode chamber to
maintain electronic neutrality with the hydroxide ions at the electrode. They combine with the regenerant
hydroxide ions to form sodium hydroxide which is then removed to waste.
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After the eluent passes through the flow cell to the detector, it is recycled back to the suppressor to be
used as the source of water for the regenerant chamber water. This mode of operation of the ASRS II is
called the Autosuppression Recycle Mode (see Figure 10).

Detailed operating instructions and troubleshooting tips are described  in the ASRS II Installation
Instructions and Troubleshooting Guide.

6.2. Autosuppression with the Cation Self-Regenerating Suppressor (CSRS II)

The chemistry of autosuppression with the CSRS II is described below and illustrated in Figures 12 and
14.

The CSRS II includes two regenerant compartments and one eluent compartment separated by ion
exchange membranes. Defining a regenerant flow channel and an eluent flow channel on opposite sides of
the membrane, the eluent flow is in a direction  that is countercurrent to the regenerant flow.

Electrodes are placed along the length of the regenerant channels. When an electrical potential is applied
across the electrodes, water from the regenerant channels is electrolytically hydrolyzed, supplying
regenerant hydroxide ions (OH-) for the neutralization reaction. The membrane passes these hydroxide
ions into the eluent chamber resulting in the conversion of the electrolyte of the eluent to a weakly ionized
form. Eluent anions are simultaneously passed into the regenerant chamber to maintain charge balance.

Figure 14 illustrates the autosuppression with the CSRS II. This example uses sulfuric acid as the eluent,
but methanesulfonic acid may also be used. The water regenerant undergoes hydrolysis to form hydrogen
gas and hydroxide ions in the cathode chamber while oxygen gas and hydronium ions are formed in the
anode chamber. Anion exchange membranes allow hydroxide ions to move from the cathode chamber
into the eluent chamber to neutralize hydronium ions. Anions in the eluent, attracted by the electrical
potential applied to the anode, move across the membrane into the anode chamber to maintain electronic
neutrality with the hydronium ions at the electrode. They combine with the regenerant hydronium ions to
form sulfuric acid which is then removed to waste.

The CSRS II also works in  the Autosuppression Recycle Mode. After the eluent passes through the flow
cell to the detector, it is recycled back to the suppressor to be used as the source of water for the
regenerant chamber water (see Figure 13).

Detailed operating instructions and troubleshooting tips are described  in the CSRS II Installation
Instructions and Troubleshooting Guide.

7. Detector

The final solution (which has been separated) enters the conductivity cell which records the conductivity
of the ions.

The DX 120 accommodates tow detector cell models: a standard cell (CDM-3) and a high- performance
cell with heater (DS4 Detection stabilizer). The DS4 is recommended for applications requiring enhanced
thermal stability and it is the one used on the ship.

The DS4 cell is a flow-through conductivity cell with a polymeric body. Two 316 stainless steel
electrodes are permanently sealed into the cell body. A sensor (thermistor) located slightly downstream
from the electrodes senses the temperature of the liquid as it exists the cell. The measured value is used
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for temperature compensation. The cell has an active volume of 1.00 µl. The detector cell constant is
calibrated electronically and has a nominal value of 160 cm-1.

The DS4 stabilizer is a temperature-controlled chamber consisting of a cast aluminum base and cover
enclosed in insulating foam. The chamber houses both the conductivity cell and the eluent heat
exchanger.

Figure 15 identifies the major components of the DS4. (P2-16 DX120 Operator's. Manual)

The DS4 is sealed with an O-ring to trap eluent that may leak from the cell. If 5 ml of liquid accumulates,
a thermistor sensor signals a leak to the CPU. Any additional leakage will be discharged via the
spill/overflow line.

See Appendix D of DX 120 Operator’ Manual for principles of conductivity detection.

For detector troubleshooting guide, see DX 120 Operator’ Manual pp. 4.12 to 4.17. For routine
maintenance of cell, see Operator’s Manual pp. 5.7 to 5.9.
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II.  OPERATION COOKBOOK

The Dionex DX 120 is used on board the Joides Resolution to determine concentrations of  cations (Na+,
K+, Mg2+ and Ca2+) and anions (Cl-, SO42-) in sediment pore waters. Cations are separated using a Ion
Pac CS12 column, anions are separated using a Ion Pac AS4 column.

The DX 120 is configured on board the ship to run in the Column Select Mode. In this mode, a dual
column system allows switching between two sets of columns. The DX 120 also gives the choice between
traditional chemical suppression or autosuppression using a self-regenerating suppressor (SRS).

The DX 120 can be controlled locally, using the front panel keypad and display, or remotely, from a
PeakNet workstation. The PeakNet workstation consists of  a PC computer (with Windows 95 OS),
Dionex DX LAN interface card, and PeakNet software.

For more details on the principles of operation of the DX 120, dual column system, auto- suppression
theory, etc. , read the "Principle of Method" section of this manual.

A.  OPERATION FEATURES

1.  Front Control Panel

The control panel liquid display (LCD) shows status information and alarm conditions. Press a button in
the group labeled DISPLAY to determine the status information shown. The remaining buttons control the
DX 120 operation.

Note: Capitalized bold type indicates a front panel button. Upper-case bold type indicates information
displayed on the front panel screen. Upper-case italic type indicates a grouping of front panel buttons.

Paste in figure 2-3 and table 2-1 of DX 120 oper. Manual (p 2-5 to 2.7)

2.  DIP Switch Settings

The DIP switch settings located on the left side of the main compartment sets the various DX 120
operating parameters. The factory default settings are appropriate for most applications.

Figure 16 shows the default DIP switch settings. Table 1 gives a description of the DIP Switch functions.
(p.B-34 to 36 DX120 Operator. Manual)

Note:  A function controlled by a DIP switch setting has the switch and position number shown in
parentheses.

The following switch settings have been modified to suit our applications:

 (SW1 - 4, 6), that is switch 1 - position 4 and 6 set to ON to select psi as pressure units and high pressure
alarm at 2500 psi.  If this maximum pressure is exceeded during the operation, an alarm is flashed on the
front panel DISPLAY and the pump shuts off.
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 (SW2 - 3, 6) set to ON to select the operating current for ASRS (100 mA) and CSRS (300 mA);
 (SW4 - 1, 2) set to OFF to select DS4 as Cell Type.
Note:  The low pressure alarm is set by default to 250 psi. It is not set from the front panel as with the DX
100. If the pump pressure falls below 250 psi, an alarm is flashed on the front panel DISPLAY and the
pump shuts off.

3. Control Modes

The DX 120 has two control modes: Local and Remote. Select Local for control from the DX 120 front
control panel and select Remote for control from a PeakNet workstation.

To change the mode, press Local/Remote button on front panel. The selected mode is shown in the lower
right-hand corner of the display.

3. 1. Local Mode

When the DX 120 is powered up, it defaults to Local mode. Local mode allows two types of operating
commands:
 Direct input from the DX 120 front control panel buttons; and
 TLL inputs from a remote controller, such as an integrator or recorder.

3. 2. Remote Mode

In Remote mode, the DX 120 accepts operating commands from PeakNet software, via the DX LAN
interface. Sending an operating command from PeakNet automatically selects Remote mode, if it was not
already selected.

In Remote mode several control panel buttons are disabled while the others remain active (see the
following table).

Disabled Button in Remote Mode Active Buttons in Remote Mode
______________________________________________________________________________

Load/Inject DISPLAY group (all)

Eluent Pressure (ON/OFF) RECORDER group (all)

SRS (ON/OFF) Pump (ON/OFF)

Column A and Column B Local/Remote

Alarm Reset

Auto Offset
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B . PREPARATION OF ANALYSIS

1. Eluent Preparation

The system uses two different eluents depending on the type of applications.

1. 1.  ELU A: Anion Eluent

The anion eluent consists of a 2.2 mM sodium carbonate (Na2CO3) and 2.8 mM sodium bicarbonate
(NaHCO3) solution to make a two liter eluent. It can be prepared in two ways:

- using AS4 eluent concentrate from Dionex (P/N 37161): to prepare two liters of eluent, pipet 20 ml of
the concentrate into a two liter volumetric flask and dilute to a final volume of two lites using nanopure
water;

- using dry powder chemicals: weigh out 0.470 gr. of sodium bicarbonate and 0.466 gr. of sodium
carbonate and dilute it to a final volume of two liter in nanopure water.

1. 2. ELU B: Cation Eluent

The cation eluent consists of a 20 mM Methanesulfonic acid (MSA, i.e.CH4O3S) solution.

To prepare two liters of eluent, pipet 2.6 ml of MSA into a two liter volumetric flask and dilute to a final
volume of two liters using nanopure water.

The eluents should be filtered through a 0.45 µm filter to remove small particles that may contaminate the
pump check valves and cause erratic flow rates or loss of prime. End-line filters (P/N 045987) are
supplied in the pressurizable reservoirs for this purpose.

The eluent reservoirs are pressurized with Helium regulated at main gas supply between 20 and 100 psi.
A regulator inside the DX 120 regulates the pressure between 8 to 10 psi.

To turn on the gas pressure to the eluent reservoirs, Press Eluent Pressure on the front panel of the DX
120.

2. Samples Preparation

2. 1. Collection and Storage

The samples should be collected in high density polyethylene containers cleaned with deionized water (no
acid). If the samples are not analyzed the same day, filter them after collection with a 0.45 µm filter and
refrigerate at 40C. Samples containing nitrite or sulfite should be analyzed as soon as possible.

2. 2. Dilutions

The samples are diluted 1: 200 for both the anion and cation analyses.

The dilution of standards varies with the type of analysis. The anion analysis uses six dilutions of IAPSO
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as standards. Standards are 10%, 20%, 40%, 60%,  and 100% of the 1: 200 dilution. The cation analysis
also uses six dilutions of IAPSO as standards. However, standards are 20%, 40%, 60%, 80%, 100%, and
120% of the 1: 200 dilutions.

Dilutions can either be done manually with the Hamilton Microlab 900 dilutor, or using the AS3500
autosampler.

2. 2. 1.  Manual--Hamilton Dilutions

The 1: 200 dilutions of the sample are made of 50µl of sample solution diluted with nanopure water to 10
ml.
For the anion analysis, standards will be prepared according to the dilution scheme
presented in Table 2. (From old dx 100 cookbook)

For the cation analysis, standards will be prepared according to the dilution scheme
presented in Table 3.(From old dx 100 cookbook) Often, the concentrations of calcium and potassium in
the pore waters may vary over a wide range of values. In order to cover the range of potential
concentration of Ca (K), it may be necessary to spike the standards with a known amount of Ca (K)
solution standard (see Table 4) (From old dx 100 cookbook).

Note:   A 1000 ppm reference standard solution  for Ca or K can be used to spike the IAPSO standards.
However, make sure that the reference solution used does not contain any nitric acid if you want to use
the same standards in both the anion and cation analyses.  The presence of the nitric acid, even in very
low concentrations will cause nitrate to elute at a retention time that overlaps the sulfate.

2. 2. 2. AS3500 Dilutions

a. Principle of Autodilution

The AS3500 uses templates built in the Peaknet software to automate the sample and standard dilutions.
Basically, a template contains a sequence of steps arranged in a preset order. Each step carries out a
specific autosampler operation or group of operations. The autosampler automatically prepares the
samples (or standards) according to the steps specified in the template.

Appendix 1 shows the templates used for diluting standards for the anion analysis (A2000--10% STD;
A1000--20% STD, A500--40% STD,  A333--60% STD, A250--80% STD, and A200--100% STD)

Appendix 2 shows the templates used for diluting standards for the cation analysis (C1000--20% STD,
C500--40% STD, C333--60% STD, C250--80% STD, C200--100% STD,  and C167--120% STD)

Appendix 3 shows the template used for the 1: 200 sample dilution (200SLP).

Within each template, the numbered steps are grouped into dilution cycles (see templates in Appendix 1-
3, steps 1-6). A dilution cycle is a sequence that transfers solvents from the solvent bottle and sample
from the source vial (s) to the target vial (s). The autosampler can be programmed to repeat dilution
cycles up to four times within a template in order to carry more complex procedures (for more details, see
AS3500 Autosampler Reference Manual p. 60).

The autosampler dilution cycle is easily understood by comparing it to the manual dilution procedure. In a
manual dilution, one draws a specific amount of sample into a pipet and expel a measured volume into a
volumetric flask. Next one dilutes to final volume with a desired amount of solvent and mixes the
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solution for a specific amount of time. In manual dilution, the solvent and sample are added to the target
container one at a time. In contrast, the autosampler first draws all the resources for a given dilution into
its solvent-holding loop and sample /needle lines (see Figure 6). An air bubble is drawn before and after
each resource to isolate it in the loop. Once all the resources have been drawn into the lines, the
autosampler delivers them to the target vial simultaneously. The vortex mixer then mixes the target vial
for the specified amount of time.

b. Preparation of Templates

To prepare a new template or access an existing one, perform the following steps:

- Double-click on the Schedule icon in the PeakNet Main menu window;
- Select Template under the File Menu of the Schedule Editor: a Template Set Up window will appear,
click OK;
- The Template Editor window will then appear: it can be used either to create a new template or to open
an existing one. All templates will be saved as .PRP files in the \DX120\METHOD directory.

The template A200.PRP presented in Appendix 1 will be used as an example of how a template works.

- In step 1, the preparation (prep) syringe draws 1500µl of solvent (from bottle labeled S1- Diluting Water
Supply) that is loaded into the solvent holding loop (see figure 6);
- In step 2, the sample syringe draws 7.5µl of standard from the specified source vial (sample vial) into
the sample lines;
- Step 3 is skipped, the sample syringe is not needed;
- Step 4 is skipped, the prep syringe is not needed;

Note:   Each pick up step allows to pick a maximum of 100µl. To pick up more than 100µl, use step 3 or
step 4 (for volume up to 1500µl)

- The Add step (step 5) delivers 1500µl to the target vial placed in the third vial subsequent to the sample
vial position;

Note :  Because the Add step uses the prep syringe, the maximum volume that can be added is the sum of
the Load volume and PickLG volume. That is one can't add (deliver to the target vial) more than has been
withdrawn into the prep syringe in the Load and PickLG syringe. Also, the template only allows delivery
of the final volume of sample/standard-- solvent to vials in the three positions adjacent to the sample vial,
Sample+1, Sample+2, or Sample+3. For example, if the sample vial position is A01, Sample+1 would be
A02, Sample+2 would be A03, etc.

- In Step 6, the sample and solvent are mixed for 30 seconds;
- Steps 7 to 10 are not used in the shipboard anion or cation applications.

After each dilution cycle, the autosampler automatically flushes its lines and syringes with flush solvent
(from Rinse Water Supply Btl). The amount to be flushed is set in the Template Set Up window
(currently set at 1000µl). Any residual sample, solvent from the previous cycle is flushed from the lines
so that the instrument is ready for the next cycle or injection.

For more details on the configuration of dilution cycles and template programming rules, read the
AS3500 Autosampler Reference Manual (pp. 51-70).
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3. Preparing the DX 120 Unit for a Run

Before starting a run using PeakNet, the DX 120 system has to equilibrate for a minimum of one hour.
Start up the system using the steps described below:

1. Press the power switch below the DX 120 front control panel to turn on the system power.
Microprocessor code revision levels are displayed briefly on the screen, and the conductivity
reading is displayed.

These are the conditions at power-up:
 The DX 120 is in Local mode;
 The eluent pressure, pump and SRS are off;
 The DS4 is on;
 The injection and column selection valve are at their last selected positions; and
 The offset value is reset to zero.
Assuming that the last column selection is the one desired, proceed as follows:

2. Confirm that eluent reservoirs are full and closed.

3. Press Eluent Pressure to pressurize the eluent reservoirs. These reservoirs are pressurized with Helium
regulated at main gas supply between 20 and 100 psi. A regulator inside the DX-120 regulates the
pressure between 8 to 10 psi.

Note:  Never pressurize the reservoirs above 10 psi.

4. Open the pressure transducer waste valve by turning the knob counterclockwise two turns. Disable
(SW1, 8).

5. Press Pump on the front panel to turn on the pump. When the valve is open, eluent will flow directly
from the pump to the waste (pressure is nil).

6.  Press Flow Setting to display the pump flow rate. Pull out the pump flow adjustment knob and adjust
the flow rate to 2 ml/mn. Push the knob back in.

7. After about 10 seconds, adjust the flow rate again to the setting required for the application. For cation
analysis, the rate should be 1 ml/mn. For anion analysis, the rate should be 2 ml/mn.

8. Leave the pressure transducer waste valve open till no air bubbles travel to pump (for 30 seconds
approximately) and then close it. The pump is primed.

9. Press SRS to turn on the power to the SRS. The screen briefly displays the SRS current setting in mA.
Enable (SW1, 8)

Note:  When the pump is switched off, the SRS shuts off automatically. However, when the pump is
switched on and flow goes through the system, the SRS has to be turned on immediately. Failure to have
current applied to the SRS will result in permanent damage to the suppressor.

10. Let the system flush and equilibrate for at least an hour.

Note: One should check the flow rate after the system has flushed for 10 mn as it tends to decrease as the
eluent flows through all the components. Pull the knob to readjust the flow to proper setting for your
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application. Check also the pump flow rate if there is a shift in retention times, or each time one switches
from one column to the other.

Check the pump flow rate whenever you change applications. Refer to section B. 5. 2. of the DX 120
Operation manual for checking procedure. If the pump has lost calibration, refer to section 5.7. of the
Operation Manual for calibration instruction

11. Press Pressure and Total Cond. to display the pressure and total conductivity readings.

When performing a cation analysis, the pump pressure should be between 1200 to 1300 psi. The total
pressure of around 1300 is obtained by adding the pressures generated by the various components of the
system. It is equal to the starting pressure (300 psi); plus guard column pressure (200 psi), plus column
separator pressure (700 psi), plus suppressor pressure (50 psi), plus cell and coil pressure (15 psi).

When performing a anion analysis, the pump pressure should be around 1100 to 1200 psi. The total
pressure of around 1200 is equal to the starting pressure (500 psi); plus guard column pressure (100 psi),
plus column separator pressure (500 psi), plus suppressor pressure (50 psi), plus cell and coil pressure (15
psi).
Cell conductivities should be around 17-19 µS for Elu A and around 0-1µS for Elu B.

Note : Make sure you have the appropriate flow rate for the appropriate column and suppressor. Flowing
only 1 ml/mn through the ASRS is okay, but flowing 2 ml/mn  through the CSRS instead of 1 ml/mn is
not good for the suppressor.

When all these steps have been performed, the autosampler should then be primed and loaded.  The run is
ready to start.

Note:  The autosampler should be primed at the start of the Leg or when a "solvent valve misaligned"
error message appears on the front panel of the autosampler.  See AS3500 Autosampler Reference
Manual (pp.115-116) for priming instructions. Solvent lines S2, S3, and S4 should be uncapped and
immersed in nanopure DI before flushing/priming the AS3500.

C. RUNNING THE DX 120 UNDER PEAKNET CONTROL

PeakNet is used to control the instrument, collect and process data, and generate reports. To start the
program, double-click on the DX 120 PeakNet icon on the desktop. The Main Menu appears as a series
of “tab pages” on which each PeakNet program is represented by a button. The DX LAN page is the one
used for our applications. The sequence of program buttons on this page corresponds to the typical
sequence of events for an automated operation: system configuration, creation of Methods and Schedules,
data collection, and review and reprocessing once data collection is complete.

Table 5 show a summary of the typical sequence of events. (PK manual p2-7)

1. Connections

The Configuration Editor configures the instrument, and the DX LAN network to the analytical system
being used. It is run during the initial installation of the software or each time a module is added or
removed from the system.
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When the system is properly configured, the system list box displays the DX LAN ID (22 03 1F) and
module name (DX 120) in black (otherwise in red). The 8-bit DX LAN card is configured with an IRQ of
10 and an I/O Address of 300h. The system is connected to the AS3500 autosampler via COM 2 port.

2. Preparation for Analysis

The first step in preparing for an analysis is to develop one or more Methods (and Schedules) for
analyzing the samples. The Method should then be tested by analyzing calibration standards, and modify
if necessary.

2. 1. Setting up a Method

Methods contain all the instrument control and data handling instructions needed to run a analysis. The
Method includes a list of the names, amounts, and retention times of the components in the standard(s)
that will be used to calibrate the system. The Method Editor program is used to create, store and edit
Method files.

2. 1. 1. Starting a Method

To open the Method Editor main window, double-click on the Method button in the PeakNet Main Menu.
When the Method Editor is initially opened, only an abbreviated version of the File Menu is displayed.
After a Method is loaded, all menus are available. The Method Editor lets you open multiple Methods at a
time. Each Method appears on its own child window.

Figure 16 shows the child window for the ANION.MET. A few key parameters for the Method can be set
directly from the windows. The control buttons are used to set many more parameters for data acquisition,
timed events, and data processing.

Under the File pull-down Menu, the first two commands are New and Open. The New command allows
to create a new Method; the Open command presents a scrolling file directory from which an existing
Method can be open and consequently modified.

Commands in the Edit Menu let you copy settings from one module to another, either in the same Method
or in two different Methods. Only settings that are compatible between the two Methods will be copied.
The procedure used to copy the settings using the Edit’s Menu’s Copy, Paste and Paste Special
commands is described in the PeakNet Software User Guide, pp. 5-7 and 5-8.

Note:  Information about the sampling rate, detector type, plot scales and timed events cannot be copied
from one detector to another.

2. 1. 2. Creating and Modifying a Method.

A Method defines two types of parameters: data acquisition and data processing parameters. When
creating a Method, one will first set up the data acquisition parameters, then the data processing
parameters.

Data acquisition parameters include all the controls related to the operation of the analytical system and
to data collection. Data Collection key parameters appear on the Method Editor window and can be set up
or modify by changing the content of the dialog boxes. Timed events or initial conditions can be set up or
edited from their Editor Dialog box accessed by clicking on the Events command button:
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 Time determines for how long data is collected by the detector.

- Rate sets the data collection rate for the detector. This determines how many data points per second are
collected and stored in memory.

- Plots Scales specify the settings (minimum and maximum for the Y-axis of the real time data plot as it
is collected) which command the display of data .These have to be set up or modify so that the peaks are
not to small to see or else so large that they go off scale on the display. This setting also affects the
printed output, unless you select Autoscale option from the Plot dialog box.

Note:  The Plot Scales settings affect only the display of the data, not the collection of raw data from the
detector.

- Events button: clicking on this button opens a Timed Events Editor dialog box. This editor allows to
create, save, and edit a file of timed events that control the chromatography. Timed events are timed
operations performed by a module during the execution of a Method. All timed events programs must
contain at least two steps: one at initial condition (INIT) and another at time 0.0. The INIT step typically
contains standby conditions for each module in the system. This allows to include system equilibration
conditions in each method. The conditions at time 0.0. take effect as soon as the module receives a
START command. Typical timed events operations include:  turning pump on and off, starting collection
of data, offsetting baseline, turning relays and AC power on and off, etc;

Refer to section 5.6. (Data Acquisition and Control) of the PeakNet Software User's Guide (pp. 5-14 to
5.18 and pp. 5-34 to 5-36) for guidelines on setting up data acquisition parameters for the DX 120.

Data Processing parameters specify how analytical data is processed, what information is introduced in
the final analytical report, and whether the data is stored on disk. The data processing icons in the Method
window let you edit five types of parameters: Integration, Data Events, Calibration, Components and
Groups, and Report. Clicking on any of the icon will open a dialog box in which these parameters can be
set or modified.

- Integration parameters specify how the acquired data is processed by the computer for peak detection
and integration. They include parameters such as peak width, peak threshold, and area reject. Refer to the
PeakNet Software User's Guide (pp. 5-40 to 5-44) for details on how to set up these parameters.
Principles of Peak Integration are discussed in Appendix A of the PeakNet Software User's Guide.

- Data Events are timed-based events that affect the detection and integration of raw data. They include
events such as: stop and start detection, double and halve peak threshold, double and halve bunching,
force baseline at the start of all peaks, etc.. For example, the ANION.MET include two data events: stop
peak detection at 0 mn and start peak detection at 1.10 mn. These events were included to ensure that the
void volume peak would not interfere with the proper integration of the Chloride peak. Refer to the
PeakNet Software User's Guide (pp. 5-44 to 5-47) for listing and definitions of all data events available.

- Calibration parameters determine how detected peaks are identified and quantified. They include such
parameters as quantification method (external standardization in our shipboard methods), number of
replicates, calibration and sample injection volume, amounts units, and linear weighing option. A
calibration update option is also available to select whether the calibration table should be updated, by
replacing the existing values in the table with new values, or by averaging new values with existing ones
(Replace mode is used for shipboard methods). Refer to the PeakNet Software User's Guide (pp. 5-48 to
5-51) for details. Appendix C of the PeakNet Software User's Guide discusses the principles of peak
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quantitation.

- Clicking on the Component and Groups button will bring up a Component Table that is used by
PeakNet to automatically identify and quantitate sample components. The Component Table has five tab
pages which lists information required for calibration calculations. The Identification page lists the name
and retention time of each standard component. The Quantitation page lists low and high amount limits
for each component. The Calibration Standard page list the various calibration levels, i.e. the amounts of
component in the calibration standards. The Calibration page lets you select the parameters to be used for
plotting the component calibration curves (curve fit type, origin treatment, calibration calculation mode,
etc.). The Check Standards lets you enter the amounts of each component in the check standards.

Clicking the Detail button on each of these pages will open the Component Data dialog box. This box
consists of three tab pages: Plot displays a plot of response vs. amount for any component of the current
Method; Replicates displays the raw area calibration data for each replicate calibration injection, at each
calibration level; and Groups lets you classify components into groups to get reports of compound
classes.

Refer to the PeakNet Software User's Guide (pp. 5-52 to 5-67) for details on the Component Table
content.

- Clicking on the Report Options button opens a Report Options dialog box that is used to access the
Report Designer program to edit a Method’s report format and to select which report to print
automatically at the end of a run. Refer to the PeakNet Software User's Guide (pp. 5-68 to 5-70) for
details on which report options are available.

Appendix 4 displays printouts of the Methods developed on Leg 179: ANMAN.MET and ANION.MET
for the anion analysis; CATMAN.MET and CATION.MET for the cation analysis. The data acquisition
parameters are listed under the DX 120 Timed Events and Detector Parameters heading of the Method.
Data processing parameters are listed under the DX 120 Integration Parameters, Smoothing Parameters,
Report Data, Integration Data Events, Calibration Parameters, and Component
Identification/Quantification/Calibration headings of the Methods.

2. 2. Setting up a Schedule.

A Schedule consists of one or more Methods linked so that they perform a series of analyses
automatically.  A typical schedule might include one or more calibration runs, analyses of several
samples, a column change and equilibration, and dilution templates. Each Schedule step specifies the
Method, data filename, and other parameters used to analyze a single injection. Schedules are also used to
specify groups of data files for reprocessing, using the Batch program (see section 4. 3).

2. 2. 1. Creating a Schedule

The Scheduler Editor is used to create, edit and save Schedules.

To start the Schedule Editor, click on the Schedule button in the PeakNet Main Menu window. The
Schedule Editor window opens and contains a blank spreadsheet in which each row represents one
injection.

Under the File pull-down menu, the first two commands are New and Open. The New command allows to
create a standard PeakNet or AS3500 schedule; the Open command presents a scrolling file directory
from which an existing schedule can be open.
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2. 2. 2.  Editing a Schedule

The Schedule Editor features true spreadsheet functionality: lines and blocks of information can be easily
cut, copied, and pasted using standard Cut, Copy and Past Windows commands from the Edit menu or
toolbar. Clicking the right mouse button anywhere on the Schedule spreadsheet displays the Edit menu.

To enter information in a Schedule spreadsheet, select a blank cell and type directly into the cell. Press
<Tab> to highlight the next cell. If the last cell in a row is highlighted and AutoCopy mode is enabled,
pressing <Tab> copies the entry of the current row to the next row if it is blank. To edit the contents of a
cell, double-click on the desired cell and edit its content or position the cursor in the correct location and
then type and delete characters as required. The Fill command in the Edit menu is used to copy the
contents of the cell in the top row of a selected block into other cells in the block.

The Options Menu is used to set: (1) default path names for a Method file and/or data file; (2) to enable or
disable the automatic incrementing of sample name and vial number (for AS3500 Schedules only); and
(3) enable or disable the AutoCopy mode.

2. 2. 3. Schedule Parameters

A standard PeakNet Schedule (.SCH extension) includes the following input fields: Sample Name,
Sample Type, Level, Method, Data File, Volume, Dilution, Weight, Int. Std., Comment. An AS3500
Schedule (.AS3) includes: Vial #, Inj. Vol/Vial, Sample Type, Level, Method, Data File, Dilution,
Weight, Int. Std., and Template. The standard Schedule can contain instructions for up to 999 injections,
the AS3500 Schedule up to 120 consecutively sequenced vials.

 Sample specifies the name of the sample (up to 31 characters);

 Sample Type specifies whether the injection is a Sample, Calibration Standard, or Check Standard;

 Level specifies the calibration level of the injection;

 Double-clicking on an empty Method cell opens the Windows common Open Dialog box. Select the
Method to be used to analyze the sample. The path for the filename is not displayed, unless it is different
form the default path;

 In Data File, type in a filename under which raw data from the analysis should be stored on disk.
PeakNet uses the following conventions for naming data files when they are created during Method and
Schedule runs: (1) an extension .dxd is added and (2) to ensure that existing data are never overwritten, an
identifying letter and number combination is added to user assigned data file names. The following
naming scheme is used: [user assigned name]-xxxyyy.dxd where xxx is a series of letter starting with aaa
that increments each time a Method or Schedule is loaded and yyy is a series of numbers starting with 001
that increments each time the Method is run;

 A Volume of the sample can be entered so that the calculated concentrations will be corrected for
differences in sample volumes;

 The Dilution factor provides a mathematical correction for dilution effect. If no dilution, use the value 1;

 Weight specifies the weight of the sample. If no variation, use the value 1;
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 Int. Std. Specifies the amount of internal standard added to each standard or sample. If no variation, use
the value 1;

The following parameters are also included in a AS3500 Schedule:

- Vial # is the vial number (A01-A40, B01-B40, C01-C40). Letter specifies the sample-vial tray (A, B, or
C) and the number indicates the vial position within that tray;

- Inj. Vol. controls the volume of standard/sample injected;

 Inj/Vial is the number of injections to be made from a vial, up to 99 are allowed;

 Template specifies a sample preparation template for processing the current vial. No injection is made
on a sample schedule line that included a template

Appendix 5 presents a description of the AS3500 Schedules used for our shipboard analyses: Adilcal.as3
or Andilcal.as3 are used for anion analysis and Cdilcal.as3 or Cndilcal.as3 for cation analysis.

Note:  The AS3500 Schedules are currently set up so that the autosampler performs Push injections. The
Flush volume is 250 µl. The injection mode and flush volume can be modify in the Run Parameters dialog
box under the Edit Menu of the AS3500 Schedule Editor window. Refer to Appendix C of the
Autosampler Reference Manual for basic autosampler theory of operation and for additional information
on various injection routines (pp. 158-168).

2. 3. Some Rules

Do not modify the original Methods, Schedules and Templates currently in memory. Rename a copy of
the original for the specific Leg, or sites, or runs.

Create a file subdirectory for the specific Leg or sites directly in the Schedule Option menu.

Clean up the disk of all Methods, Schedules, Templates, data files that will not be used again.

3. Performing a Run with PeakNet

The Run Program conducts the analyses specified in Methods and Schedules. Run can perform module
status display, Method and Schedule loading, real-time data display, data reduction, report printing, data
storage, module Direct Control, and modification of a running Method. Run also controls the AS3500
Autosampler through the RS-232 interface.

Clicking on the Run button in the Peaknet menu will open a System Window (see section 3. 4. for details
of System Window features).

3. 1.  Starting a Manual Injection Run

Starting a Manual Injection run can be done using either a Method or a PeakNet Schedule (which stores
the Method).
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3. 1. 1. Using a Method

Selecting Load Method from the File menu and then a Method file from the dialog box will open the
Load Method dialog box. This dialog box contains three tab pages: Sample, Injection, and Modes. To set
up a manual run, proceed as follows:

• In the Sample Tab page, specify: Sample Name and Type, Sample Level for Calibration or Check
Standard injection, Data File prefix and path; Detector Type and Run time;

• In the Injection Tab page, specify: Injection Volume, Dilution Factor, Sample Weight and Int.
Standard amount;

• In the Modes Tab page, select Start/Via Run Menu Command to start the timed events for the
loaded Method by selecting the Run Start Command.

Remote is displayed on the front panel of the DX 120 (and in Module Status Display). Sending
commands via PeakNet will automatically select this mode. As a result the Load/Inject button is disabled
and the injection is commanded by the Method Timed Events (set for Injection valve to switch to Inject at
0.01 mn and then back to Load at 1 mn). The Module Control and System Status bar shows “Ready”.

To manually inject a sample or standard, fill the syringe with the sample or standard (make sure there are
no bubbles of air), insert it into the port on the front of the DX 120, overfill the sample loop with several
sample loop volume, and leave the syringe in the port with enough volume to make a second injection.

Under the Run menu, select Start.

After the run is finished, and the data report is printed, to continue injecting samples or standards using
the same method, click on the Start Run button in the Run Toolbar. The Load Method dialog box opens
again: entering a new Sample Name in the Sample Tab page is now all that is needed. Click OK and the
next run starts. And so on.

Note:  When a injection is commanded by the Method only, the End and Abort commands are disabled, i.
e. one cannot stop the run once started.

3. 2. 2. Using a PeakNet Schedule

To start a manual injection run with a Peaknet Schedule, select Load Schedule from the File menu and
select a Schedule file (.SCH) from the dialog box (it automatically loads the Method stored in the chosen
Schedule). The Load Schedule dialog box appears and contains three tab pages: Data, Batch, and Modes.

• In the Data Tab page, specify:  Number of Loops for the Schedule, i. e. the number of times the
Schedule is to be run, Starting Line # for the Schedule, and Data Paths from the Schedule or other
directories (Store All Data Files in Directory);

• The Batch Tab page is used to have the Batch program automatically reprocess data upon Schedule
completion;

• In the Modes Tab page, specify to Start Successive Runs automatically.

Prepare for injection as described above and select Start under the Run menu. See section 3. 3 for details
on how to End and Abort a Peaknet Schedule.
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Note:  PeakNet will not pause in between injections to ask you whether you are have loaded the next
sample and are ready for the next injection. Therefore, after the injection valve has switched from Inject
back to Load for a particular sample injection, prepare your next injection by loading the sample loop
with the next sample, and so on.

3. 2. Starting an AS3500 Injection Run

To start an AS3500 run, proceed as follows:

 Select Load Schedule from the File menu and choose a Schedule file (.AS3) from the dialog box The
Method stored in the Schedule is then automatically loaded. The Load Schedule dialog box appears with
its three tab pages: Data, Batch, and Modes.

 In the Data page, specify the starting line # for the schedule. Ignore the Batch page;

 In the Modes Pages, the Start Successive Runs will default to “Upon Receiving Signal at Module”. This
option allows to defer the start of the timed events from the next Method until the module receives a
signal from the AS3500. It enables the AS3500 to signal the DX 120 that the next sample has been loaded
and is ready for analysis.

On the DISPLAY of the front panel of the DX 120 (and in Module Status Display), the Remote  is
selected. The injection is commanded by the AS3500 not the Timed Events. The Module Control and
System Status bar shows “Waiting for External Start”.

 Once the vials are set up in the autosampler tray, select Start AS3500 from the Peaknet Run menu.

Note:  When you select an *.AS3 Schedule, the Run program converts it line by line to an *.SCH
Schedule before downloading it to the DX 120. Although multiple injections per vial are listed on a single
line in the *.AS3 Schedule file, they are listed on separate lines in the *.SCH file. Therefore, the number
of lines in the *.SCH file equals to the total number of injections in a run. The results of each injection are
stored in a separate raw data file.

3. 3.  Ending and Aborting a Run

Select the End Command from the Run menu to finish a run early and keep the data from the run.

End...terminates the running Method and the Schedule. It quickly executes the last timed events and
leaves the system operating under the conditions specified in the last timed events step. When a method is
loaded, the injection number in the Module Control Bar is set to one. When the methods is ended, Run
increments the injection number by 1.

After using the End command, restart a run as follows:

 If no AS3500 Autosampler is configured, select the Start command again. Run will restart from the
current injection number;

 If an AS3500 Autosampler is configured, you must reload the Schedule because Run does not
automatically reload *.AS3 Schedules. Run will restart from the line number specified on the Load
Schedule (Data page) dialog box.
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Select the Abort Command from the Run menu to finish a run early and discard the data from the run.

Abort...terminates execution of both the Method and Schedule. It quickly executes the last timed events
and leaves the system operating under the conditions specified in the last timed events step. Selecting
Abort does not change the injection number displayed in the Module Control Bar.

After using the Abort command, restart a run as follows:

 If no AS3500 Autosampler is configured, select the Start command again. Run will restart from the
current injection number;

 If an AS3500 Autosampler is configured, you must reload the Schedule because Run does not
automatically reload *.AS3 Schedules. Run will restart from the line number specified on the Load
Schedule (Data page) dialog box.

3. 4. System Window

A System Window consists of three main areas:

 Module Control and System Status Bar;

 Module Status Display; and

 Detector Real-Time Plot(s).

The following figure displays the System window for a cation run test on the DX 120.

SCAN HERE run.wpg

3. 4. 1. Module Control and System Status Bar

Run continuously communicates with each module listed in the PeakNet.CFG file: if a module responds,
its icon is displayed in the Run system window. There is only the DX 120 module for our applications.
Double-clicking on the DX 120 module’s icon allows to edit the timed events for the DX 120.

The system status may be any of the following:

 Not Loaded: when no Method is yet loaded;

 Ready: when the System is ready to begin running after you have clicked on  the Start button;

 Waiting for External Start: when a Method is loaded, but the system waits for an external signal from
the Autosampler before starting the run;

 Running: the system has been started and a Method is running;

 Ended: timed events and data acquisition are completed, but the Run program has not finished
processing data, or else the Method has been ended and the data has been saved;

 Done: the Run program has uploaded and processed all data, or else the method has been aborted and the
data has been discarded.
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3. 4. 2. Module Status Display

The Module Status Display provides an overview of the status of the DX 120: pump status, eluent
pressure status, settings for flow rate and pressure, injection valve status, setting for offset and total
conductivity, detection mode, Method status and run time.

3. 4. 3. Real-Time Plot

After a Method is loaded, a detector window containing a graph appears and, as data collection progress,
data is drawn on the graph. The Y axis represent the detector response in µS, the X axis shows the unit of
measurements. The Scaling Toolbox at the right of the plot allows you to zoom in and out of the Plot
Dialog box.

For details about the Scaling Toolbox and the Plot dialog box, see Chapter 10 and 12 of the PeakNet
Software User’s Guide.

4. Post Analysis Data processing

The Component Table (Data Plot Page), Optimize, and Batch programs are used to examine the results of
a run, manipulate the data, reintegrate peaks, view the calibration curve, compare plots, print
chromatograms and reports.

4. 1. The Component Table Data Plot Page

The Data Plot page is used to check and manipulate the calibration curves of components used in the
Methods. To access the Data Plot page, load the method of interest and click on the Component table icon
of the Method Editor. Clicking on the Detail button on any of the Component Table pages will open the
Component Data dialog box. This box consists of three tab pages: Plot, Replicates and Groups (not used)

4. 1. 1. Plot Page

Plots displays the calibration curves of each component.

The information in the plots can be altered by checking or clearing various options in Display. You can
choose to include the amount/response data points for each calibration level, draw the calibration curve,
and display with an X the location of each point not used in the plot (Rejected Pts.).
Error bars is used to display a bar between replicate values of one standard deviation or more. Narrower
bars indicate closer replicates values, wider bars indicate greater deviation in replicate values.

Residual values is used to display the plot of residuals versus amount. It is the difference between the
actual response of a calibration standard and the response that would have been expected based on a
regression curve. For each point a circle indicates the residual value, with a vertical line indicating the
difference from the ideal residual value of zero.

Confidence Intervals draw curves showing the confidence intervals for the plot. The confidence intervals
are calculated using a t-test at 95% confidence (only for Externa Linear calibration).

Replicates displays the area values by either Replicate or Level. When Level is selected (using View), the
table displays all replicate data values for the selected level. Rows are labeled R1, R2, etc. Unused
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(empty) levels are not included. If Replicate is selected, the table displays a data value for each level of
the selected calibration injection. Rows are labeled L1, L2..L7. The Use column is used to choose which
replicate values to use in the calibration plot.

The equation for the calibration curve fit is displayed at the bottom of the page along with the R2 value of
the selected component. The ideal value is 1.

The calibration curves for all components of the Component Table can be printed by selecting the Print
command.

4. 1. 2. Replicates Page

Replicates displays the raw area (height) calibration data for each replicate calibration injection, at each
calibration level.

Component is used to select the component for which to display the replicate data. View selects whether
to display Area or Height calibration data for the selected component.

Note:  The values in this Table cannot be edited. If peaks are un or mis-identified, correction of area
values in the calibration curve will have to be done by using the Optimize program, more specifically the
Name Peak and Calibrate commands in the Operations menu. See section 4. 2 .2.

4. 1. 3. Shipboard Calibration Check Procedure

After you run is finished, proceed as follows to check and update your calibration:

1. Load your Method in the Method Editor;

2. Double-click on the Component Table icon and then on the Detail button to open the Component Data
dialog box;

3. In the Plot page:
• Check the outlook of the four component calibration curves and their R2;
• If the curve is not very linear, i.e. if there are outlier data points, check the replicates for each
calibration level;
• Select Replicate #1  in the View box (Rows are labeled L1, L2..L7 for levels 1 to 7);
• Select the Use check box to indicate which replicate values of Levels 1 to 7 you wish to keep in the
calibration plot, rejected values require a comment in the Comment field ;
• Do the same for Replicate 2;

4. In the replicate page:
• Replicate values in this table cannot be edited;
• If peaks are un or mis-identified, correction of area values in the calibration curve will have to be
done by using the Name Peak and Calibrate commands in the Operations menu of the Optimize
program;
• Rejected replicates will be displayed with a line across them.

5. Save the Method after your changes.
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4. 2. The Optimize Program

The Optimize program is used to explore the details of a chromatogram, fine-tune the integration, assign
peak names, and update Method files and data files with new parameters. Multiple data files can be
compared. Mathematical operations can be performed on one or two data files and the results plotted.

To start the Optimize program, double click on the Optimize button in the PeakNet Main Menu.
A blank Optimize window will appear. Load a data file and the Edit Windows opens.

The bottom part of the Edit Windows shows the complete chromatogram (Reference Plot), with a
highlighted area indicating the view shown in the upper part of the Edit Windows. The plot displayed in
the top part of the Edit Windows is called the Scalable Plot. The upper right part of the window shows the
Scaling toolbox which can be used to modify the view of the Scalable Plot by enlarging it, reducing it,
zooming in and out, etc. Refer to the PeakNet Software User's Guide (pp. 10-5) for details on the Scaling
toolbox button functions.

Six pull-down menus control the Edit Windows: File, Edit, Operations, View, and Scale Menus.

4. 2. 1. File and Edit Menus

The File menu (or first six buttons of the Edit Windows toolbar) is used to: (1) Open Data File (up to
eight windows); (2) Open a Method File to replace in active memory the Method currently used to
interpret open raw data file; (3) Open Dataview to select up to 12 data files for display in a Comparison
Window; (4) Save Data File newly optimized to disk; (5) Save Method File to extract a Method that has
been deleted or modified since the data file was generated; (6) Export (to Database) raw data values of a
chromatogram in a format compatible with other software (or  data’s file and peak information to a
database that supports ODBC); and (7) Print Sample, Calibration Standards, or Check Standards Reports.

The Smoothing, Integration, Data Events, Calibration, Component Table, Report Parameters of a Method
can all be access and edited directly from the Edit menu of the Optimize program (or button 7 to 12 on
the Edit Windows toolbar).

4. 2. 2. Operations Menu

The Operations menu can be used to: determine ideal Peak Threshold (Auto Threshold), adjust
integration of a chromatogram, reintegrate baselines manually, name (rename) un(mis)- identified peaks,
and update the calibration table.

Note:  When you select a command from the Operations menu or click on one of the equivalent toolbar
buttons (13 to 18), a set of controls for the type of operation drops below the toolbar. To remove the drop-
down controls, select the Return to Normal Display command or click on the Normal button (13).

The Auto Threshold (14) feature evaluates a section of baseline, displays the average noise for the
baseline, suggests a threshold that prevents baseline being interpreted as peaks, and, if accepted, updates
the current threshold. To determine the Auto Threshold of a chromatogram loaded in the Scalable Plot,
first locate a peakless segment of the baseline that is representative of the entire baseline. Place the mouse
cursor at one end of this segment, press and hold the main mouse button while dragging the cursor to the
other end of the segment, and release the mouse button. Click on the Measure command button and a
suggested threshold value is displayed. Repeat the measurements on a different segments of baseline and
Click Accept to have the chromatogram reintegrated with the most representative threshold value.
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Clicking on the Adjust Integration toolbar button (15) opens the Adjust Integration drop-down controls.
Any changes made with these graphics controls can be saved to the Method and applied to other
chromatograms.

Change the Peak Width before using other integration features to fine-tune data. The Peak Width control
is usually used to re-integrate a lengthy chromatogram in which narrow peaks increase to wide peaks as
the run progresses. If a peak’s tick mark is not at the apex, the Peak Width is probably too wide and you
should select a narrower width. The best way to optimize is by on screen-experimentation. Move the
Time-Scale cursor to a point immediately before the area where you want to change the peak width, click
the cursor on wider or narrower, and then click on the Re-Integrate command button. Once the Peak
Width is satisfactory, adjust the Integration Modes and the Peak Events.

Integration Modes represent  data events that can be turned on and off at selected time in the run. To turn
an event on (or off), move the hairline Time-Scale cursor to the point at which you want the event turned
on (or off), click on the check box for the event, and then click on Re-Integrate command button. This
will modify peak integration throughout the rest of the run. Peak Events modify only a specific peak.
Activation of a Peak Event will depend on the types of peaks. Refer to the PeakNet Software User's Guide
(pp.10-17) for details on the Peak Type and Peak Events activation procedure.

The Peak Threshold changes very little from the value provided by the Auto Threshold. Minor changes
can be made to balance modifications to Peak Width or to compensate for increased noise level.

To re-integrate baselines manually, click on the Manual Baselines toolbar button (16).  Click on the peak
number in the Peak Selection window to select the peak whose baseline you want to modify. Start (green)
and Stop (red)  markers will indicate the beginning and end of a peak. To change the start time of a peak,
point to the peak’s Start marker and drag it to the point you want the peak to start and release the mouse
button. Similarly, to change the end time of a peak, point to the peak’s Stop marker and drag it to the
point you want the peak to stop and release the mouse button. The new Start and Stop time will be
updated in the Peak Selection window. Additionally, you can Split, Delete, and Merge peaks. Re-detect
will delete all the results of all baseline changes made during editing and returns the chromatogram to its
previous configuration.

The Name Peaks command is used to ensure proper peak identification. Clicking on the Name Peak
toolbar button (17) drops down a control with five drop-down list  boxes:  peak retention time, component
name, component retention time, reference component, and tolerance.

To match unidentified peaks to correct component peak, first select the peak of interest by clicking on the
peak’s retention time in the Peak Ret. Time drop-down list. Information will appear in the five boxes on
top of the Name Peak window if the peak is identified as a component. If the peak is not identified
properly (boxes will be empty), open the drop-down list box under Component Name to see whether the
peak component is already listed. If it is, select it to display the current component information. Update
the component time by selecting the new time from the Component time drop-down list (or move the
Retention Caliper over the correct peak). If the component name is not listed, type the name in the
Component Name box and press [Tab] to enter the peak time as the Component time. Edit the Reference
Component and Tolerance, if desired, then press on <Enter> to save your changes. The new component
assignment is now entered in the component table and should appear in the scalable plot .
To match misidentified peaks to correct component peak, first select the peak of interest. Check the
reference component, if any, to make sure that the reference component’s Retention Caliper is centered
over the reference component peak. Eliminate any Tolerance overlaps by typing in a narrower Tolerance
for overlapping Retention Calipers. Select the first component from the Component Name list, then center
the Retention Caliper over the proper peak. Repeat for all other components.
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Click on the Calibrate toolbar button (18) to calibrate the Method with the current data file and update
the height, area, and retention time values for each peak, or just the retention times. Calibrate is normally
selected only after all other adjustments to the Method have been completed.

4. 2. 3. View and Scale Menu

In the View menu, Overlay Plots is available, in the Comparison Window, to display compared plots on a
single set of axes. Selecting (or deselecting) the Reference Plot, Baselines, Dynamic Threshold, Start/Stop
Markers, Peak Fills, Peak Labels displays (or removes) the corresponding graphics feature from the
chromatogram.

The commands on the Scale menu are also available from the Scaling toolbox but are not available if a
Comparison Window is open.

4. 2. 4. Math Operation Menu

The Optimize program can calculate and plot the mathematical sum, difference, or ratio of any two raw
data files. It can also calculate and plot the first and second derivatives of a stored raw data file. The
results can be stored as a new data file and used to improve plot quantitation. For example, a baseline data
file can be stored and subsequently subtracted from each sample data file. The resulting file can be
reintegrated, to improve quantitation of detected peaks.

Refer to the PeakNet Software User's Guide (pp. 10-30 to 10-31) for a description of the Math Operation
procedure.

Note:  Double-clicking anywhere on the displayed plot open a Plot Properties dialog box that lets you
change the scale, font, line colors (style and weight), labels, and other properties displayed in the PeakNet
programs. The dialog box is also available from the Run and Report Designer programs. Refer to the
PeakNet Software User's Guide (pp. 10-32 to 10-41) for a description on how to change Plots’ properties

4. 3. The Batch Program

The Batch Program is used to reprocess previously stored data files in a group instead of individually. To
do so, Batch requires a Schedule that lists all the data files to be reprocessed and a Method to be used.
When the reprocessing is complete, Batch can store the reprocessed data as new files, print new reports,
update the Method, and export the results to spreadsheets and database programs.

To open the Batch main window, double-click on the Batch button in the PeakNet Main Menu. Select
New under the File Menu to reset Batch to the program defaults.

Reprocessing of a group of data files is done using the Processing menu. Processing Options specify
which files are to be reprocessed, the type and content of any printed report, and what occurs to raw data
after reprocessing. The Processing Options dialog box contains three tab page: Input, Output and Export.
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4. 3. 1. Input

In the Input page, reprocessing is select to be done using either the Select or the Build command.

Select lets you specify an existing Schedule to reprocess.

Build lets you create a new Schedule from a list of raw data form the Build Schedule dialog box.  From
the Data Files list box, double click on a raw data filename (or use Add) to add it to the Chosen Data Files
list. When you are finished, click on the Exit command button. This close the dialog box and prompt you
to Save (specify a new name) the new Schedule.

After specifying the Schedule to use during reprocessing, the Input page lets the operator specify which
files to reprocess (Process Injections From X Through X) and the reprocessing Methods: from Schedule
or from Data Files.

From Schedule uses the parameters of the Methods specified on the Schedule. This option is used if you
want to reprocess the data files with an updated Method file. From Data File uses the parameters of the
Method that is embedded in the data files. This option is selected if calibration files have changed or if
baselines have been drawn manually since the Schedule was last run and you do not want to overwrite the
changes.

4. 3. 2. Output

The Output options are used to specify the report types to be printed at the end of the Batch processing
(Calibration Update, Check Standards and Summary Reports) and to determine how disks files are
updated.

Update Methods from calibration standard updates the Component Table of each Method used to
reprocess the data whenever a data file with the sample type Calibration Standard is processed. This
updates peak areas and heights for each component.

Update Raw Data Files stores reprocessed data files on disk. When you select this option, the original
data points and instrument control timed events remain unaltered. However, sample names, Methods
names, Method data reduction parameters, volume, dilution factor, and Int. Std amount in each raw data
file will be replaced by those values in the Schedule.

Discard Manual Baselines causes Batch to ignore any baselines established manually in the Optimize
program.

4. 3. 3.  Export

Export options allows to create a CSV file to be imported to Excel. To do so, enter the filename and path
for the file to be exported. Select the desired overwrite option for the report (Ask, Append, or Overwrite),
report type (Summary or Full), and summary options (if summary type selected) and then click Start from
the Processing menu to begin the Batch reprocessing and exporting job.

The Summary Options select the type and format of information to be included in the report.  Fields lets
you select the Header and Data fields to include in a Summary report. One Line Per Injection generates
one set of Header fields for each injection and repeats the Data fields N times, where N is the number of
components in the detector Method processed. The component name is included with each Data field.
One Line Per Peak generates one line in the report for each peak that is output. The first line contains the
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column labels for each Header and Data fields. The Data fields are only output once and the component
name is not included with the fields.

4. 3. 4. Shipboard Reprocessing Procedure

To reprocess a PeakNet or AS3500 Schedule, proceed as follows:

1. Double-click on the Batch button in the PeakNet Main Menu. Either select New under the File Menu to
reset Batch to the program defaults or Open to load a batch setting file which contains your specifications
for reprocessing options (e.g. Anion.bch ).

2. In the Input page:
• Select the Schedule (*.SCH) for the run to be reprocessed using either the Select or Build
Command;
• Specify first and last of injections to be reprocessed. If the Component Table has been modify in the
Method, do not reprocess standards, only checks and samples;
• Select Process Methods from Schedule if Method was updated, or from Data files if the calibration
files have changed or if the baseline have been drawn manually, since the Schedule was last  run;
• Click on OK

3. In the Output page, select Update Raw Data Files and click on OK.

4. In the Export page:
• Enter the Excel filename (*.CSV) and path (e.g. C:\DXEXPORT\CAT1105.CSV);
• Select Summary for the Report Type and One Line Per Injection for the Summary Options. The
Summary fields are: Sample Name and Component Amount;
• Click on OK.

5. Select Start command in the Processing Menu.

Refer to the PeakNet Software User's Guide (pp. 11-1 to 11-14) for a detailed description of the Batch
program commands discussed above.

D. SHUT DOWN PROCEDURE

The shut down procedure can be done using the front panel keypad or PeakNet. Proceed as follows:

Using Front Panel Keypad:

• Rinse for 30 mn with Elu A (column set A) or Elu B (column set B) after the run is finished;
• Press on Local/Remote button to select the Local mode (SYSTEM CONTROL group);
• Press on Pump button to turn the pump off (Pump LED not illuminated), this will automatically shut
down the SRS (COMPONENT ON/OFF group);
• Press on Eluent Pressure to turn gas pressure to eluent reservoirs off (LED not illuminated);
• Switch the main Helium supply off and release pressure in the lines by opening one of the
pressurized reservoir.

Using PeakNet:

• Rinse for 30 mn with Elu A (column set A) or Elu B (column set B) after the run is finished;
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• From the Run menu (or toolbar), select Direct Control to open the Direct Control Dialog box;
• Stop the pump by selecting Pump Off, this will automatically shut down the SRS;
• Turn off the Helium pressure to the reservoirs by selecting Eluent Pressure Off;
• Switch the main Helium supply off and release pressure in the lines by opening one of the
pressurized reservoir.

Note: If used daily, leave the DX 120 power On. If not used daily, avoid column contamination and dry
out by flushing eluent through both sets of columns every week. Make sure you have the appropriate flow
rate for the appropriate column set.

E. COLUMN SWITCHING

The steps of the Column Switching procedure vary slightly depending whether one switches from column
set A to column B, or from column set B to column set A. It can be performed using the front panel
keypad or PeakNet.

1. Switching Column Set A to Column Set B:

To switch from column set A to column set B, proceed as follows:

Using the Front Panel Keypad:

1. Rinse for 30 mn with Elu A after the Anion run is finished;

2. Disable (SW1, 8);

3.  Press Flow Setting to display the pump flow rate (DISPLAY group). It should be 2 ml/mn. Pull out the
pump flow adjustment knob and adjust the flow rate to 1 ml/mn for cation analysis. The pressure will
drop to reflect lower flow rate;

4. Press Column B button on the front panel keypad (COLUMN SELECTION group);

5. The following occurs:
• The eluent selection valve switches and Elu B begins flowing to the injection valve (of DX 120 or
AS3500 Autosampler);
• The display flashes RINSE;
• The injection valve switches to the Inject position, to clear the previous eluent from the sample loop;
• A delay occurs before the column switching valve switches to the new position. This allows Elu A
to continue to flow through column set A. The duration of the delay depends on the current flow rate.
Lower flow rate require a longer rinse time;
• When Elu A has been cleared from the lines, the column switching valve switches and Elu B flows
to column B set. Pressure rises as Elu B flows through the column set B components;
• The injection valve returns to the Load position;
• The RINSE indicator stops flashing and the display shows the new column selection.

6. Verify pump Pressure (DISPLAY group). If the pressure does not rise to appropriate values for Cation
set up (around 1200 to 1300), the pump needs priming;

7. Enable (SW1, 8);



Cookbook - Chem_DX120 manual
33

8. Let system equilibrate for at least an hour and occasionally verify flow rate, pump pressure and total
conductivity.

Using PeakNet:

Replace step 4 in the above procedure as follows:

4. Load a Cation Schedule file (*.SCH for manual injections and *.AS3 for AS3500 Injections) from the
Run File menu. The Cation Method stored in the Schedule is then automatically loaded. The Timed
Events set up in the Method will automatically initiate the column switching sequence from column A set
to Column B set because Column B was the one selected in the Set Up dialog box of the Method.

Note:  Pump and Eluent Pressure status, Flow Rate and Pressure settings, Injection Valve position, Offset
and Total Conductivity settings can be monitored using PeakNet from the Module Status Display in the
Run System Window.

2. Switching Column Set B to Column Set A:

To switch from column set B to column set A proceed as follows:

Using the Front Panel Keypad:

1. Rinse for 30 mn with Elu B after the Cation run is finished;

2. Disable (SW1, 8);

3. Press Column A button on the front panel keypad (COLUMN SELECTION group);

4. The following occurs:
• The eluent selection valve switches and Elu A begins flowing to the injection valve (of DX 120 or
AS3500 Autosampler);
• The display flashes RINSE;
• The injection valve switches to the Inject position, to clear the previous eluent from the sample loop;
• A delay occurs before the column switching valve switches to the new position. This allows Elu B
to continue to flow through column set B;
• When Elu B has been cleared from the lines, the column switching valve switches and Elu A flows
to column A set. Pressure is relatively low as it reflects the lower flow rate of the Cation set up (1
ml/mn);
• The injection valve returns to the Load position;
• The RINSE indicator stops flashing and the display shows the new column selection.

5.  Press Flow Setting to display the pump flow rate (DISPLAY group). It should be 1 ml/mn. Pull out the
pump flow adjustment knob and adjust the flow rate to 2 ml/mn for Anion analysis. The pressure will rise
to reflect higher flow rate and flow through the column set A components.

6. Verify pump Pressure (DISPLAY group). If the pressure does not rise to appropriate values for Anion
set up (around 1100 to 1200), the pump needs priming.

Note:  Priming the pump and several readjustment of the flow rate to 2 ml/mn was necessary every time a
switch from column B to column A was performed on Leg 179.
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7. Enable (SW1, 8);

8. Let system equilibrate for at least an hour and occasionally verify flow rate, pump pressure and total
conductivity.

Using PeakNet:

Replace step 3 in the above procedure as follows:

3. Load a Anion Schedule file (*.SCH for manual injections and *.AS3 for AS3500 Injections) from the
Run File menu. The Anion Method stored in the Schedule is then automatically loaded. The Timed
Events set up in the Method will automatically initiate the column switching sequence from Column B set
to Column A set because Column A was the one selected in the Set Up dialog box.

Note:  Pump and Eluent Pressure status, Flow Rate and Pressure settings, Injection Valve position, Offset
and Total Conductivity settings can be monitored from the Module Status Display in the Run System
Window.

F. EQUIPMENT SET UP

1.  DX 120 Rear Panel

The fuses are below the power cord fitting.

The Helium pink line used to pressurize the eluent reservoirs is installed in a push type fitting (i.e. to
insert the tube, push the tube in and pull the red plug out). DIONEX recommends to use Helium, instead
of Nitrogen, at a pressure between 20 to 100 psi. There is an internal regulator that regulates the pressure
to the eluent reservoirs to around 7 to 10 psi;

The DX LAN card connects directly to the PC LAN card via a BNC cable.

The TTL Inputs and Outputs are connected from the DX120 to the AS3500 autosampler as follows:

• TTL Input Ground of DX 120 to Ground #1 of AS3500;
• Inject/Remote Start of DX 120 Gradient Start Output #4 on the AS3500;
• TLL Output Ground of DX 120 to Ground #1 of AS3500;
• TTL1 of DX 120 to Inject Hold Input #7 of AS3500.

Figure B-15 (p. B-27) in the DX 120 Operator’s Manual illustrates the connections between the two rear
panels.

Note:  The Gradient Start Output on the AS3500 should be set to active high in the Set Up Menu of the
AS3500 Autosampler.

There are four wastes lines: one for injection valve waste (not used with AS3500), one for pump waste,
one for ASRS waste and one for CSRS waste.
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2. Inside the DX 120 Instrument

The power switch is below the display of front panel. The manual injection port is located in the center
bottom part of the DX 120 door.

The pump is a single piston pump. The pulse dampener is behind the back wall of the instrument.
The cell is a DS4 with a thermal stabilizer (heater). Two DS4 cables are connected to the DS4 connector
and the Cell Connector respectively. The DIP switches have been set for DS4 use and adjusted for our
applications (see highlighted settings p. B-34 of the DX120 Operator’s Manual). Notice the spill/overflow
line and the two coils from the cell outlet to port #5 of the switching valve.

The chromatographic components (inside the door) are plumbed for a dual-column system (Column
Select Mode) with SRS. Column connections are described page B-20 and SRS connections page B-19 of
the DX120 Operator’s Manual. Each peek line has actually been labelled by DIONEX and it is very easy
to make the connections (see p.2-22 for a flow schematic);

The injection valve (bottom valve) is used for manual injection. The Injection Valve connections are
described p. B-40 of DX120 Operator’s Manual

The switching valve (top valve) controls all the flows of the dual column system. When the DX120 is
connected to the AS3500, this valve is the only one in use (see p.B-41 of the Operator’s Manual for
Column Switching Valve plumbing).

Note:  DO NOT change the length of (do not shorten or lengthen!) any of the peek lines. The switch of
flow path from one column to another takes into account the distance between the different components
and the timing is such that there should be only a little eluent carry-over when switching columns set.
However, the first injection run after switching columns should be ignored.

The lines connections between the DX 120 and the AS3500 are as follows:

 The pump pulse damper (red PEEK) is connected to port 5 of the AS3500 autosampler     
rheodyne valve;

 Port 6 of the AS3500 rheodyne valve  is connected directly to the switching valve (port 2);
 the injection valve of the DX 120 is bypassed (port #2 and 3 are capped).
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